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Introduction:
MacSnoop™ was developed to fill the gap left when FEDIT was removed from the shareware market a 
number of months ago.  I became frustrated by not having an editor capable of working with HFS and the 
new 128K ROMs and began to write my own.

While not yet up to the full capabilities of FEDIT in terms of file recovery tools, it does have many wished 
for enhancements not the least of which is full HFS and MFS support.  In addition, the overall design 
allows multiple volume/directory and editing windows open on the Desktop and a closer adherence to the 
Macintosh User Interface.

Additional Information:
Since this program is aimed at the sophisticated Macintosh user, I don't go into a detailed description 
of the Macintosh Operating System.  The information you need to digest in order to  understand disk 
and file formats is contained in Inside Macintosh™ Volume II and Volume IV (published by Addison-
Wesley Publishing Company).

DEMO/REAL Version?
Please note that there is a naming convention in place to differentiate between the “Demo” version 
and the “Real” version: The “Real” version is called “MacSnoop™” and the Demo version is called 
““MacSnoop™”.D”. This is important and their names must remain as such in order to work properly.

In the “Demo” version of “MacSnoop™” everything functions exactly like the real version except that 
there is a trial period of two (2) months. I feel this is sufficient time to decide if you like it or not. At the 
conclusion of the trial period, “MacSnoop™” will deprotect your files/folders and post a message 
telling you the trial period has expired each time you run it. Your hard disk will be completely 
deprotected at this time.

Please send in your shareware contribution in time to avoid the inconvenience of not having 
MacSnoop™ available to use.

CAUTION!
MacSnoop™ is a tool that, if misused, can be hazardous to the health of your files, micro disks and 
hard disk!  MacSnoop™ will allow you to write to any block on a disk, including ones maintained by 
the Macintosh Operating System.  If you do wish to modify some information, be sure you know what 
you are doing.  Carefully check and recheck the changes to wish to make and when you feel confident 
that the changes are ok, check it again!  Once MacSnoop™ has written a block out to a disk, there is 
no Undo to save you from mistakes!!  If at all possible, you should work with a copy of your disk or file, 
not your original.

Credits:
As usual, there are a few people that I want to thank for helping with this program. First, my wife (Renette) 
and son (Eric) who have to share me with my Macintosh. I know it's a trial sometimes to understand why I 
spend time away from them writing software, but they are very understanding and I appreciate it a lot.
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Legal Disclaimer
MACPASSWORD™ IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OR 
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.  THE ENTIRE RISK RELATED TO 
THE QUALITY AND PERFORMANCE OF THE PROGRAM IS ON THE LICENSEE.  IN THE EVENT 
THERE IS ANY DEFECT, THE LICENSEE ASSUMES THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR, OR CORRECTION.  IN NO EVENT SHALL THE AUTHOR ( EVERGREEN 
SOFTWARE, INC.) BE LIABLE TO THE LICENSEE FOR ANY DAMAGES (INCLUDING AND LOST 
PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT 
OF THE USE OF OR INABILITY TO USE SUCH PROGRAM EVEN IF THE AUTHOR (EVERGREEN 
SOFTWARE, INC.) HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES) OR FOR ANY 
CLAIM BY ANY OTHER PARTY.

Distribution:
MacSnoop™ is being released to the shareware market in the hopes of capturing some of the good will 
that seems to exist out there.  The jury is still out on the profitability of shareware so let's see if we can 
avoid the hassles of copy protection, fancy packaging and higher prices by supporting this industry.  If you 
like MacSnoop™ then please contribute $25.00 in US funds (non-US orders add $4.00 extra P&H) to:

Evergreen Software, Inc.
15600 NE 8th Street, Suite A3126

Bellevue, Washington
98008

In return for your contribution, I will send a disk to you containing the latest version of the REAL 
MacSnoop™ and it's documentation. This version will have an unlimited life (ie. no two month trial period). 
As a special bonus, I will include MacSpool™, a TEXT file print program that allows you to 'que' up to 50 
files to printed.  MacSpool™ uses the low-level text streaming features of the ImageWriter™ or 
LaserWriter™ to provide extremely rapid output.  I wrote it because I got tired of waiting for the high level 
Print Manager routines to print my source files in graphics mode when all I really wanted was a fast draft.  
Note, this program will print 40-50% faster than the 'draft mode' available from the high level Print 
Manager routines!

In addition, as a registered owner, you may elect to upgrade your MacSnoop™ at any time by sending in 
your original MacSnoop™ disk along with a self-addressed, stamped envelope and $3.00 (US funds).  I 
will return the latest version to you as quickly as possible.

Special Notice (“Sale and Profit Clause”):
MacSnoop™.D (ie. the DEMO version only) may be distributed everywhere for evaluation; it may not 
be sold or offered for sale, or “included” with another product offered for sale, except with the express 
written permission of the author (aka me...). This includes the so called “public domain/shareware” 
disks or hard disk drives containing “public domain/shareware” which are sold for profit . If you want to 
include MacSnoop™.D on such a volume, ask me and we’ll work something out. I did not write this 
utility for the profit of another person.  Ignore this clause and feel the wrath of my attorney!

(National services, such as CompuServe, GEnie, DELPHI, etc; and BBS’s which charge a fee for 
membership but not for each download; are specifically excluded from this “sale and profit” clause… 
go ahead and post it.)
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Bug/Suggestion Reports:
I'm extremely interested in receiving information on suggestions for new versions as well as (gasp!) bugs. 
Reports can be sent to me via my home address or the following networks:

         DELPHI:GPSART
         GENIE:GPSART

Environment:
MacSnoop™ has been tested on a Macintosh Plus with an HDSC-20, a Macintosh SE with a built-in 20 
meg hard drive, and a Macintosh II with Apple's 40 meg internal hard drive..  Also, it seems to perform 
properly running under Switcher and MultiFinder with 256K of memory.  I've had some reports of some 
problems when running under the 'old' 64K ROMs.  I can't test it on an 'old' Macintosh so... let's say that it 
only supports the new 128K ROMs.

The block editing routines have been written to provide support for hard disks up to 512M in size.  Be 
advised that the time to search a disk or file is proportional to its size!  It could take minutes to complete a 
search of a 100M disk (hint: use CMD '.' to abort a long search).

If you successfully test MacSnoop™ on any particular piece of hardware, I would appreciate knowing 
about it so that I may pass it along to others with similar configurations.  I would like to make sure that 
MacSnoop™ works on all the combinations of hardware/software.

Installation:
MacSnoop™ is easy to install. It can reside in any folder of your volume. To launch MacSnoop™, just 
‘Open’ it from the Finder like any other application.

MacSnoop™ Windows
Directory Window

When MacSnoop™ first starts up, a small window, like you would find in ResEdit, is opened for each 
volume that is mounted (either hard disk or micro disk).  Each window contains the names of all the 
files found on the volume in the root directory.  A small icon is used to indicate whether the file is an 
application, a document, or a folder.  A close box drawn in a volume window indicates that this is an 
ejectable volume (ie. micro disk).  Clicking in the close box will remove all windows associated with 
this volume from the Desktop and eject the disk.
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HFS directory windows will also have a close box that, when clicked in, will remove just that window 
from the Desktop.

Keyboard Shortcuts:
The arrow keys (on the Macintosh Plus keyboard and the numeric keypad) are fully supported for 
directory/volume windows.  Their use is as outlined below:

up & down arrow: move selection up or down one file.
(with CMD key): moves to first or last file.

In addition, by typing an alphanumeric key, the directory window will scroll to show the first file that 
starts with that key (I will be expanding this capability later to provide full type-ahead).

Maintenance Window

An editing window appears when you elect to open a file or volume for editing.  The window displays 
the contents of the first block in both hexadecimal and ASCII.  Only 256 bytes of the block are 
available for editing at any one time, however you may scroll the display vertically to view all parts of 
the block.  Scrolling horizontally will move you sequentially through the file or volume.
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The top half of the window gives you information relevant to the current cursor position as well as the 
absolute block position within the file or volume.

Keyboard Shortcuts:
The arrow keys (on the Macintosh Plus keyboard and the numeric keypad) are fully supported for 
editing as well.  Their use is as outlined below:

up & down arrow: move selection up or down one line.
(with CMD key): move to first or last byte in block.
right & left arrow: move selection forward or back one byte.
(with CMD key): move to first or last byte on line.

MacSnoop™ Menus
Apple menu:

The Apple menu contains “About MacSnoop™”, a Shareware Notice and all the desk accessories 
contained in your System file.

About MacSnoop™…
This command displays a dialog containing a little blurb about MacSnoop™ and the plea to send 
money so I can feed my family (just joking… they get at least one meal a week as it is now…).

Shareware Notice…
Please read this information about the terms and conditions of use for MacSnoop™. In order to 
create more utilities like this, I need to feel that the shareware market is a viable place to do 
business. Please support this effort!

Desk Accessories
MacSnoop™ fully supports all of the desk accessories available from your system file.

File menu:
Most of the File menu items are only used when a directory/volume window is active.  Common tasks 
you would perform in the Finder are located here for convenience sake.

New… - /N
This command presents a dialog to allow you to specify a name to be used for creating a new file or 
directory.  It will create a zero length file with no file type or creator.  You should fill in the rest of the 
attributes with the Attributes command.

Under HFS, a new directory can be created instead by clicking in the folder checkbox.
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Open - /O
This command opens an editing window for this file according to the current setting of the fork flag 
in the Options menu.  If the resource flag is checked, then the resource fork will be opened, 
otherwise the data fork will be opened.  If there is no information in the selected fork, MacSnoop™ 
will inform you of this fact so you may select the other fork.

Under HFS, opening a folder will produce another directory window containing all the 
files/directories within.

Shortcuts:  A double-click on a file/directory or pressing the return key on a selection will perform 
the same as above.

Klose - /K
Performs the same as clicking in the close box of a window.  Choosing this command will close any 
type of window on the Desktop (desk accessories, directories, removable volumes, or edit ).  Note 
that a non-removable hard disk will not have a close box.

Rename… - /R
This command presents a dialog to allow you to change the name of the currently selected file or 
directory.

Information… - /I
This command presents a dialog to display detailed information on the selected file/directory.  If 
there is more information than can be displayed, scroll bars will become active and allow you to 
move around the window.

Delete… - /D
This command presents a dialog to ask you if you really want to delete this file/directory from the 
volume.  If deleting a directory, the file system will only allow the deletion if the directory is empty.

NOTE: This is a REAL delete, not like in the Finder where you can put something in the trash and 
later pull it out again.  Make sure you really want to perform this function before you click Ok!

Shortcut: If you hold the Shift key down while invoking this command, the verification dialog will be 
skipped and the file(s) will be deleted without asking you.  Be careful with this one.

Lock - /L
Performs a file lock on the currently selected files/directories.  The lock flag is displayed for each file 
that has successfully been locked.

Unlock - /U
Performs a file unlock on the currently selected files/directories.  The lock flag is not displayed when 
a file is unlocked.

Attributes… - /L
Presents a dialog with the attributes of the currently selected file/directory and allows you to change 
them.

Page Setup…
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Presents the standard Page Setup dialog box to allow you to select the special effects you want to 
use for printing.

Print…
Presents the standard Print Job dialog box to allow you to select the page range, number of copies, 
etc.  Pressing the OK button will commence the printing of the current block.

Note: This command is only enabled if an Editing Window is active.

Quit - /Q
Closes all the windows on the Desktop and returns to the Finder. Note, if you've changed a block in 
a file or volume and have not saved it yet, you will be prompted one last time to find out if you really 
want to throw the changes away.

Volume menu:
All of the Volume menu items are only used when a volume window is active.

Open
Opens an editing window for the active volume.

Rename…
This command presents a dialog to allow you to change the name of the active volume.

Information…
Presents a dialog to display detailed information on the active volume.  If there is more information 
than can be displayed, scroll bars will become active and allow you to move around the window.

Eject - /E
Removes all windows on the Desktop associated with this volume and eject/unmount the volume

Reformat…
This command is only enabled if the front most window is the volume window for a small (micro) 
disk.  You will be presented with the same dialog you see from the Finder to format the disk. If 
successful, a new volume window will be presented.

NOTE:  This command will not allow formatting of a hard disk (for your protection).

Edit menu:
Contains the standard editing functions common to all Macintosh applications as well as a few 
particular to MacSnoop™.

Undo - /Z
Only available when a desk accessory or editing window is active.

If an editing window is active, Undo will allow you to reverse all the changes made to the current 
block you are editing since the last time it was written to a volume..

NOTE: If you’ve written your changes to a volume.... it’s too late to reverse the action. Make sure 
you really want to change something before writing it back to a volume.
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Cut - /X
This option is only available when a desk accessory window is active.

Copy - /C
This option is only available when a desk accessory window is active.

Paste - /V
This option is only available when a desk accessory window is active.

Clear
This option is only available when a desk accessory window is active.

Find… - /F
Presents a dialog to allow you to specify a search string (in ASCII or hexadecimal).  When Ok is 
clicked, the search for this string starts at the current position in the editing window and continues 
until either a match is found, the Logical End of File is reached or CMD '.' is pressed.

Find Again - /A
This command starts a search for the previously entered search string at the current position in the 
editing window and continues until either a match is found, the Logical End of File is reached or 
CMD '.' is pressed.

To ASCII Edit - /T
Allows you to toggle between editing the ASCII or hexadecimal representation of the current block 
in the active editing window.

Modify Block - /M
Allows you to specify whether it is OK to modify the contents of the active editing window or not. 
You may also click on the ‘Modify Icon’ to toggle its current state:

Options menu:
All of the Options menu items are only used when an editing window is active.

NOTE: The ‘Resource Fork’ and ‘Data Fork’ options will not be available for the editing of a volume as 
a volume doesn’t participate in the ‘fork concept’.

Resource Fork
A check mark by this command indicates that the next editing window opened for a file will contain 
the first block of the file's resource fork.

Data Fork
A check mark by this command indicates that the next editing window opened for a file will contain 
the first block of the file's data fork.
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Next Block - /.
Performs the same as clicking in the right-hand arrow of the horizontal scroll bar in the editing 
window (ie. moves you forward one block in your file or volume).

Previous Block - /,
Performs the same as clicking in the left-hand arrow of the horizontal scroll bar in the editing 
window (ie. moves you back one block in your file or volume).

Beginning Block - /B
Performs the same as moving the scroll box in the horizontal scroll bar of the editing window to the 
extreme left side (ie. moves you to the first block in your file or volume).

Ending Block - /E
Performs the same as moving the scroll box in the horizontal scroll bar of the editing window to the 
extreme right side (ie. moves you to the last block in your file or volume).

Read block… - /R
Presents a dialog to allow you to specify which absolute block within the file or volume being edited 
you wish to edit.

NOTE: You may enter the block number in decimal or hexadecimal notation.

Set EOF…
Will present a dialog to allow you to set the Logical End of File to the start of the file (effectively 
creating a zero length file), to the position of current editing cursor, or to the Physical End of File 
mark.

Write Block - /W
This command allows you to write the current block back to disk after first asking for verification that 
you really want to do this.

CAUTION: Make sure you really want to write the modified block back out!  Once written, you can 
not Undo the changes!

Environment
This command displays a dialog containing information obtained from the new SysEnvrions trap. 
Good for a quick check to see things like which System File version is currently active.

Window menu:
With any program that can generate a lot of windows, it's important to offer the user some easy way of 
managing them.  These options are for that purpose.

Center Window - /S
Only enabled if the front most window is an application window (no desk accessory windows.  
When invoked, this command will center the window for any size screen.

Active Window
There will be a list of all the windows open on MacSnoop™’s Desktop here with the currently active 
one (ie. front most) having a check mark by it. Just select one of these windows to make it the 
active window.
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Transfer menu:
The Transfer menu items are available anytime to allow you to leave MacSnoop™ for another 
application.

Pick a Program
A standard Standard File dialog box  is opened to allow you to select a file to launch..

Filename #0...Filename#9
Using Apple’s ResEdit, you may fill in the full pathname of up to 10 applications that can be 
launched from MacSnoop™

Version Information
v1.5.5 as of October 3, 1989

Fixed: New Address and phone number. No functional changes

v1.5.4 as of April 30, 1989
Fixed: Fixed a small bug with properly recognizing a 68882 FPU on an SE/030.

v1.5.2 as of April 11, 1989
Fixed: Oops! Fixed a bug whenever you did a MouseDown in the menu bar on an ‘old’ Macintosh. 

This was a nasty bug that escaped me because the 68020 is very lenient about address 
errors and the 68000 is not. Wouldn’t you know my development environment is 68020 
based… I will be testing on a ‘plain jane’ 68000 before I release again.

v1.5.1 as of April 8, 1989
Added: Directory attributes are now able to be changed via the same attributes menu commands 

that has worked for files before.

v1.4.4 as of August 5, 1988
Changed: Rewritten documentation and recompiled under LightSpeed C 3.0p4.
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